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Microsoft PowerPoint

*MS PowerPoint is an application software, is a
program to represent work

*MS PowerPoint can create/ build
© Presentation Slide
© Audience handout (handout document to audiences)
0 Speaker’'s Note (script for a speaker)

O Qutline page (a page of outline to be presented)
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MS PowerPoint 2007: screen Layout
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Screen Layout — Quick Access

Toolbar

® Contains often-used commands.

% You can press the downward arrow to customize the
toolbar.
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Screen Layout — The Ribbon (1)

= 92 - U‘.:jl;r* = pp204100-thai - Microsoft PowerPaoint
! Home | Inse:t Design Animat'mns Slide Show Review "u"iew
|, /. & cut =] Layout ~ (a oo |[=0) | [l = - |[= a=|[f=. | i} Text Directian
j 26 |A A |bJ |::|' = ’=’_-— =_-—| V= |
= =5 Copy B Reset e | | = =] Align Text
|| Paste .w / 1
| | B I H a.hs E = C-:umrert to SmartArt

= F Format Fainter Slrdev 4 Delete
Clipboard F] slides Font i Paragraph

Home: Clipboard, Slides, Fonts, Paragraph, Drawing, Editing

Insert: Tables, Illustrations, Links, Text, Media Clips

Design: Page Setup, Themes, Background

Animations: Preview, Animation, Transition to this slide

Slide Show: Start Slide Show, Setup, Monitor

Review: Proofing, Comments, Protect

View: Presentation Views, Show/Hide, Zoom, Color/Grayscale, Window, Macros
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Screen Layout — The Ribbon (2)

® Extra tabs can appear when you select an object



|
Screen Layout — MS Office Button

® Open, Save, Print, Send
Ca
*New Presentation @

" You can start a new presentation from
* Template
* Themes

* Blank Presentation
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Templates

® A PowerPoint template is a pattern or bluep

slide or group of slides
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Agendas

Budgets
Content slides
Design slides
Expense reports
Forms
Inventories
Labels

Memos

Plans

Purchase orders
Resumes
Statements

Templates: Examples

Award certificates

Business cards
Contracts
Diagrams

Fax sheets
Gift certificates
Invitations
Letters
Minutes
Planners
Receipts
Schedules

S}@Jimg)ﬁoweﬁoim

Brochures

Calendars
Databases
Envelopes
Flyers
Greeting cards
Invoices
Lists
Newsletters
Postcards
Reports
Schedules
Time sheets
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Themes

®To give your presentations a designer-quality look
— a look that includes one or more slide layouts
with coordinating colors, a matching background,

fonts, and effects, you'll want to apply a theme.
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Themes

Available Templates and Themes

o=

~ |

Aljacency

& Home * Themes

Sl -

Austin

Concourse

Black Tie

Couture

Cinvi

Elemental
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Blank Presentation

New Presentation

Templates

Fqﬁlank-and recent ]

Installed Templates
Installed Themes
My templates...
Mew from existing...
Microsoft Office Online
Featured

Agendas

Award certificates
Calendars

Cantent slides
Design slides
Diagrams
Envelopes

Flyers

Forms

Greeting cards
Invitations
Invoices

Labels

Plans

Planners

Prasentations

|

[

e

Search Microso

ft Office O

fi

ratemplate

Blank and recent

-

Blank
Presentation

Recently Used Templates

Concourse

Fitchbook

—
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Blank Presentation
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Open and save

“ Open
> MS Office Button =2 Open — Select File

p
¢ Sav

> MS Office Button 9 Save as 9 LR8N version
@’ Type in File Name - OK
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Different views in PowerPoint

Presentationl - MM

O oV
:  Home Insert Design Animations Slide Show Review

ml%lulﬁ e e e B R

Slide MNotes Slhide Slide Handout MNotes Zoomn
Sorter Page Show Master Master Master Message Bar D‘lllttl-l:n'l

Presentation Views Show /Hide

® Creating or editing
“ Normal view
O Slide Sorter view
“ Notes Page view

O Master views
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Adding New Slide

® Add new slide : Home tap —2 New slide

‘n& H - O = I
7 |ome | inset  Desi
| 4 S i) Layout ~
g’ "_."ﬂﬂﬂlt
Pa.ﬂt f New ].jﬂ‘ﬂl'tl
| Clipboard h |

®  Or Press CtrlI-M
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Different views in PowerPoint

=

=

Home

U -
Insert

-

| Sorter

Slide

Design Animations

EBENENGE =

Notes  Slide

Page Show Master Master Master

Pregsentation Views

¢ Normal

Slide Show

Ruler
- Gridlines

Presentationl - M
Review

14
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O For editing and creating new slides

¢ Slide Sorter

0 See the ordering of slides

® Note Page

0 Add notes to the slides

¢ Slide Show

o Show the presentation

Slide Handout MNotes Zoom
Message Bar Duldl-l}ﬂ
Show /Hide
a0

204100 MS PowerPoint
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Slide Master

o s e o e i =

Menus Home Insert Design Transitions Animations  Slide Show

= Slide Sorter £ Slide Master [ Ruter Q
-
Motes Page Handout Master Gridlines

=

Mormal _ _ _ Zoom Fitto | Color/Grayscale Window | Macros
44 Reading View | [5 Notes Master Guides Windaow - -
Presentation Views | Master Views Show T | Zoom | | | Macros |
= | E = l

® Used for:
? Make Changes to All Slides
? Adding and Changing Layout
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Note Master

\u-u-—uj | Mates Master ! Home Insert Review View

= W 7] | | o
[T e v O oo
o L : i Slide Image || Body Fonts ~
1 Page MNotes Page Slide il " Themes [] Hide Background Graphics
e Setup Orientation =~ Orientation = V| Footer _?j Page Wumber - @ Effects ~
i — | Page Setup | Placehalders Edit Theme Background 7
EEa .y

El MNotes
Master

Click to edit Master title style
» Clickto edit Master text styles

Click to edit Mastertextstyles
Second level
Third level
Fourth level
Fifth level

204100 MS PowerPoint

19



Home Tab

¢ Slide Layout

® Change Font Typeface and Size
® Alignment & Text Direction

® Drawing

® Editing

204100 MS PowerPoint 20



Slide Layout

® On a slide, Define
(S| 8 e o [ == ’

Urban F

0 Containers

O Positioning

Content with
Caption

Picture with
Caption

Title Slide 'Il'ltleand Cuntentl Section Header O Format
S sl ¢ Can add your own on Slide
o 2| | B A
Two C;J-ﬁtent-“ ----- O Title Only Master
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Change Font Typeface and Size

ign Animations "h.aLiE_e Show Rewvi
Calibri Eu - | A & - A
Theme Fonts Cotibrrtomem— |11~ | AT a7[[ %]
I Calibri |B I U b & - A“'Hﬁ- '|
1M Calibri

Font Fa |

Recently Used Fonts
{} Arno Pro Smbd

All Fonts ONS WITH TISHTLY PACHED TEXT #
(} Adobe Caclon Pro o

00K PRESENTATION INCLUDE:
() Adobe Caslon ProBold
{F Adobe Gatamond Pro
{} Adobe Garam ond Pro Bold
M Agency FB
i ALGERIAN |

layouts to enable com
ickly and accurately
and among sections of slides

ication of lar

= Home tab and then dick to dropdown
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Change Text Color

Calibri [Body) Sl 1 L |A A ||%|I| = _'Hi_ i'=|[
B I U e & 5- Aa-|| A~ |||

Font

Standard Colors

S"EEEER
Recent Colors

|
+a) | More Colors...
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Alignment
®*Home -2 alignment e
9 Align Left == =s(= :
? Center o h
9 Align Right
O Justify

204100 MS PowerPoint 24



Indentation & Paragraphs

® Increase or Decrease Indentation to Lines of Text

Paragraph Ma

25



Text Direction

Change the direction of text

Select the text, then go to Home Tab — Text Direction

[llﬁ‘-m-:t Direction = | ]
ABC Horizontal
%
= Botate all text 90
[
A2 Rotate all text 270°
=T
Paragraph = &
o B Starked
C
|Ifi More option

204100 MS PowerPoint 26



Selecting Objects

® Click on the object you want to select

® Depending of type of objects, additional tabs will

appear
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Formatting Objects

® Change the Appearance of 22 Shape Fill -
7 Shape Outline ~

Objects (text box, shapes, etc.) - B Shape Effeds »

¢ Can change:
B Objects’ Color (Shape Fill)
© Objects’ Outline
o Adding Effects to Objects

28



Shape Fill

® Adding/Changing Fill Color of an
Obiject
® Select the object, then go to

B Home Tab —>» Shape Fill

% shape Fmﬂ 4 Find

Theme Colors
H HEEEREREE®

Standard Colors

H B CEEEER
Recent Colors
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Shape Outline

® Adding/Changing Outline of an
Object

O Type of line

o Color
o \Weight (width)
© Select the object, then go to

" Home Tab — Shape Outline

<t» shape Fill = 34 Find

\[Z Shape -GI.I‘H"IH'EM!’EI al: Replac

Theme Colors
] | # R R B B B

Standaﬂl Colors

s B B BB
_Rﬂcﬂﬁtﬂ-ﬂlﬂﬂi

|| Mo Outline

+2) | More Cutline Colors...
= Weight 3
zzzz | Dashes 3

[
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Shape Effect

® Adding/Changing Effects to an
Object, such as:

0 Shadow

0 Glow
© Select the object, then go to

" Home Tab — Shape Effects

~ 2b» shape Fill ~
L= shape CQutline ~

i T Shape Effects *-]

- [:J P
_ sraaen

- 31



Quick Style

¢ Adding Styles (fill + outline + effects) to an Object quickly.

¢ Select the object, then go to

o Home Tab — Quick Styles

ilmll%llu][ H J

_'\

-I--.
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Arrange

¢ Changing the Order of Objects

O Which one appear in front/in the back of others
® You can also group objects
¢ Select the object(s), then go to

B Home Tab —>» Arrange
O Then select the ordering/grouping

Ti Bring to Front
9L | sendto Back
@ Bring Forward
E. | 3end Backward
Group Objects

E Group

IEI Ungroup

5% | Regroup
Position Objects
|=  Align

k| Rotate

Et;. . Selection Pane...
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The Insert Tab

Insert Tab
H9- -0 3 Presentationl - Microsoft PowerPoint

Home - Animations Shide Show Review View
T | ) B U))j“ Q@ LA 3 4802

Table Picture Clip Photo Shapes SmartArt Chart Hypetlink Action Text Header WordArt Date Shide Symbol Object

Art Album~ = Box~ & Footer - & Time MNumber
|| Tables Links I Text I

® Table ®Photo Album  ®Chart
® Picture ® Shapes ® Hyperlink
*Clip Art ® Smart Art ¢ Action

More details @
204100 MS PowerPoint 34



Insert Table (1)

* Insert Tab —> Table | |bal| B B
'Tai;h_- Picture Clip Phntuv Shi
o Select dimensions of cells then press Enter of e —
: N { I |
Left Click OO000O0000n
_ N I
¢ Table Tools Tabs will appear %%%%EE%EEE
o Desian N A
g N O [ [
N { I |
= LayOUt EE Insert Table...
Eﬁ Drraw Table
EEI Excel Spreadsheet
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Insert Table (2)

® Design Tab is for changing the look (border, color)

o)\ H2-0 8 )¢ pp204100-thai - Microsoft PowerPaint Table Tools
i e——
Home Insert Design Animations Slide Show Review View Design Layout
W Header Row | First Column —— — . ﬁShading' &/ é - —_—
| | . 7
| Total Row I Last Column === g = == b i Borders g A 1pt v
: = === . - Quick Ciraw  Eraser
|¥| Banded Rows [ Banded Columns | wdf Effects = Styles~ (447 £ Pen Color = Tahle
Table Style Options Table Styles Word&rt Styles ™ Craw Borders

¢ Layout Tab is for changing how cells/table are

positioned

[ d9-05 )¢ pp204100-thai - Microsoft PowerPoint Table Tools

.I k- 1 - -- e e
Home Insert Design Animations Slide Show Review View Design Layout

mran = e 1 y = 3| Height: 1627 2 Bring ta Front * |2 4
h E Eg = :‘ % 11| Height: 041" & HEDistributeRows || E|E F Hm‘ f--'J : - || HaBing L. g
: i) o Width: 9" * ||| By Sendto Back * 1] Groi
Select  View Delete | Insert Insert Inset Insert || Merae Split || = wigth (2,257 :'mDistributeColumns Sl &Tet Cell el . .
v Gridlines | ~+ | Above Below Lleft Right || Cells Cells | ™ ' = = 'Direction * Margins + || [/ Lock Aspect Ratio “ﬁ}ielemonPane Sk Rot:
Table Rows & Columns Merge Cell Size Alignment Table Size Arrange
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Insert Picture

* Insert Tab — Picture ﬁ‘f’

0 Select the image you want

O Click Insert

® Format Tab (Picture Tools)

@ Alter color, shapes, position, even which part will be shown

(crop)

I | -_H -0 t@: i pp204100-thai - Microsoft PowerPoint | Picture Tools

Home Insert Design Animations Slide Show Review View | Format !

& Brightness ~ & C Pict . Picture Shape ~ Bring to Front = |2 Align - %
ix Brightness ﬁ ompress Picturas @ icture Shape "Eﬁ ring to Front = |2 Align E= é” Height l2.19'

T (| [Fem| FE e R i !
(P Contrast = ﬁChangePicture -d d id i ‘ d - E_"PictureBorder' LEaSe:nld’mBalck' %Graup-

%Recolor' @ResetPicture 7| & Picture Effacts %Selection Pane [l Rotate -
Adjust Picture Styles Fi Arrange Size 37
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Clip Arkt G,

Insert Clip Art S R —
2 o .
®Insert Tab — Clip Art 8 it et o s 3

Clip
Art

O Clip Art panel will appear

0 Use keywords to search for clip arts

* Type keywords under Search for:

*Click Go

- (8] organize dlips. ..
Ejaﬂ Clip art an Office Online

&4 Tips For finding clips 38



Insert Shapes vy I
P & i L
® Insert Tab —> Shapes H, AR TSR e

Lines

S T S T R R
0 Select the shape you want HoDEOOOO0

Basic Shapes

. . HEoAMNITACTOOO®®
o Then click-and-drag to draw it on the |[3$$98rL7o000
O30 14 %

lide >0 EOTHEPP T
Sli € dvnpoD» RN
(ELela!

Equation Shapes
qp = & == 5 58

F_Iowcha‘rl‘
mlat=Yslnls[wlsl=YeT=lv,
ODOAMNRDB X e AVED
QBOO
_Slals_amtﬂann_ﬁs
i A S SRR ROFOE R0 R 0 £
sl 28 () €3 [T (0 (R 02

Callouts

(2l G2 §2 €3 A8 AR (&l A A i A A
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Insert SmartArt

® Premade combination of texts and shapes

* Insert Tab —> SmartArt *
* Select SmartArt
®Make changes as you'd like

O Type in Text
B Change Color and Layout
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4
i
&

[

List
Process
Cyde
Hierarchy
Relationship
Matrix

Pyramid

F
=
T
e 9

|

|- |

Basic Block List

Use to show non-sequential or grouped
blocks of information, Maximizes both
horizontal and vertical display space for
shapes.

Cn) 9~ V)
! el

Home Insert Design
i ({3 Add Bullet @ Promote
2 Right to Left | 9 Demote
add o
Shape = & Layout = | ] Text Pane

Create Graphic

pp204100-thai - Microsoft PowerPoint

Animations

Slide Show

Review

Wiew

AV £ A

Layouts

Design

4]

| SmartArt Tools

Format
18]
L] ﬂﬂ

Colars =

| A | A A&
aanoe | AN | AR

Choose a SmartArt Graphic

B oal

8= List

&

Process
Cyde
Hierarchy
Relationship

Matrix

% Pyramid

& Bl B L

11

AV E A

Basic Pyramid

Use to show proportional,
interconnected, or hierarchical
relationships with the largest component
on the bottom and narrowing up. Level 1
text appears in the pyramid segments
and Level 2 text appears in shapes
alongside each segment.

N,

AALdAA

Smarthrt Styles
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Insert Chart

® Graphical Representation of

Data (graph)

Insert Chart

® Insert Tab — Chart {g _ o Is_%_l A.ﬂ;: QK&
; el Lo
o Select Chart Type r— " <
1 s erieil is . z'_i'sma[;s S — _E'_j .'
° Type in Data on e
Spreadsheet | —— —
o 1220
o Adjust Details j
6
o 7 Series1
Design, Layout and 3 1
. 4 M Series 3
Format Tabs will appear = =

Category 1 Category 2 Category 3 Category 4
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Insert Text Objects

Insert Tab
D.& b9 0 Presentationl - Microsoft PowerPoint

Home @ Design Animations Slide Show Review

DOxgByYPd - _IJAEJDQ'EI

Tlhle Picture Clip Photo Shapes SmartArt Chart | Hypedink zt Tm Header WordArt Date Slide Symbol Object
At Album~ - Box~ & Footer - & Time Number
| Tables Links [Tet ]
® Text Box

O Insert Tab — Text Box

@ Click and Drag to position the text box

“ Type in the Text

43



Text Objects

A=| Add text

Text

. click text box —> drawing text box —> typing letter

A Add word art

WardArt
* (Click word art —> select type —> typing letter

£2' Add symbol

Symbaol

Click Symbol —> select symbol — insert

¢ When you select a shape or a text object, Format tab (Drawing Tools) will appear
i _ﬂ -0 %‘_ x pp204100-thal - Microsoft PowerPoint Drawing Tools
Home Insert Design J}.nimatimys Slide Show Review View B ;:O_H;IE; | .
e vz i . 3 Shape Fill + - A TextFill - T Bring to Front ~ | Align + S |
A ED @. (5~ [Abc ] [ Abc ] Abc ] [ Shape Outline - A A -l @Text Qutline = | & Send to Back - E Group i ;
R A O [ Tet Box = 3 ShapeEffects' - 7 [\ Texteffeds~ |y Selection Pane  S) Rotate v L

WardArt Styles F] Arrange Size 44
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Adding Header and Footer

® Insert Tab — Header and Footer

Slide | plates and Handouts |

Il o sl apply to Al
Date > [ pate and time: ————
B Time - ; EI:IIZI|':.-'
Text Update autormatically | Apply |
"1 | i | Cancel
Language: iCalendar type:
Siide | Thai Thai Buddhist v |
Mumber Hggd |
s Preview
| 28/09/52

{| Slide nurmber

Header

& Footer [ ]Don't show on title slide
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Links
Q

*Hyperlink =

Link

O Create Link to web page, picture, e-mail, other slide
0 Select object — Insert tab —> Hyperlink
® Action

% Add the action to the object selected what will be

happen when click or moving mouse cursor over it.

9 Example.

B Select object — Insert tab — Action
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Design Tab

®Page Setup & Slide Orientation

2]x]

pe 5
i s ATt T
Slides sized For: Cirientation
: ! on-screen Show (4351 Slides
| _ \ width: Al ) Portrait
— - ‘ 25.4 E: £ (%) Landscape
F'EI-EI = HE—'_ghLI Motes, handouts & outline
Setup | £ E_I o b (%) Portrait
Murnber slides From: ®) L.;ndscape
L |

® Themes'

¢ Background

204100 MS PowerPoint

Slide
iCrientatio

i

r'l"'

FPartrait

Landscape
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Theme

sert | Design | Animations  Slide Show Review  View Farmat

m L "

. nCoFors ¥
- Fonts *

7 [O]effects

® Theme

0 Design — select theme

®To apply new colors to a theme:

o Click the Colors drop down arrow ‘

0 Choose a color set or click Create

New Theme Colors

1ins Arrobat

-

Colors
Built-r
H ENEIEND
| e ]
| miwinl( [ 1]
N EEEEED
HCNDNNEN
N EEEEEn
H ENEEEN
H EEERER
EOREOEO0O
I EEECEN
B ENCNEN
ECOCONNERER
| ]| (m

| el e |

RORECCEN

U aOmDOEen

N ENEN
B NEEEEN
HDEEEEN
N NEEEEN
N NEEEEN

Ofthice
Grayycale
Apex
Aspect
Civi
Cancourse
Equity
Flgw
Faundry
Median
Metro
Madule
Opulent
Qnel
Qrigin
Paper
Salstice
Technic
Trek
Urban

Verne

-.- Create Hew Theme Calors...
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Background

® Background

Design —> Background styles

@ Background 5tyles -

|'_ Hide Background Graphics | »

Background |

49



Slide Show

| @ R RN Presentationd - Microsoft PowerPoint Drawin
~ Design Animations Slide Show Review View Developer Add-Ins Acrobat Fon

5 I _';J ] k. Record Narration {@l Resolution: Use Current Resolution =

I Rehearse Timings [aF) Shaw Presentation On: -

From From l::u-;tum SetUp  Hide
| Beginning Current Skde | Slide Show = Shde Show Shde ¥ Use Rehearsed Timings Use Presenter View
Start Slide Show Set Up Monitgrs
E‘ b m _igv
From From Custom

Beginning Current 5lide ' Slide Show =
Start Slide Show
204100 MS PowerPoint 50




Slide Slow (cont.)

¢ Custom Slide Show

0 Show chosen slides and ordering
© Set Up (default) Slide Show

0 Show Type

0 Screen

O Custom Order
® Hide (current) Slide
¢ Record Narration

¢ Rehearse Timing

204100 MS PowerPoint
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Animations Tab

¢ Slide Transition
¢ Slide Animation

® Animation Preview

204100 MS PowerPoint 57



Slide Transition

| Animations | Slide Show Feview Developer Add-Ins Acrobat

:EL, Transition Sound: | [Mo Sound] ~

Jm =) = Eh e e—

Transition to This Slide

4 k

0 Slide transitions are the animation-like effects that
occur in Slide Show view when you move from one

slide to the next during an on-screen presentation.
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Using Slide Transition

® Transition Effect
® Transition Sound
® Transition Speed

® Apply to All
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Slide Animation

¢ Animation effects and sounds
can add excitement to your
presentations and help you
emphasize key points while you

deliver the slide show

® To Apply an Animation Effect

a

O

Select the object

Click the Animations tab on the

Ribbon
Click Custom Animation
Click Add Effect

Choose the appropriate effect

55



Custom Animation

© Effect Options
O Effects
% Timing

® Ordering

204100 MS PowerPoint 56



Animation Preview

®To preview the animation on a slide:

O Click the Preview button on the Animations tab

|_|_1=,1'-Q H-Q )+
L Ced

Home Insert Design |

' w: Mo Animation -

|| Preview Fgﬂiustnm Ani.ma.ti.unl

1| Preview Animations
204100 MS PowerPoi - . 57
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Printing Slides

® Handouts

® Notes pages st

Sradr Haradeara
[ REE) [ T E—
Srader ok 1T g
Srnioat Friarr ikl

® Presentation

Handouts for note taking ’/’

P rinding im Motes Poges

® Qutline view e e

Thoms ronfiom th ra e e M s Chorieny Thm
R

Prinding in Oufing View

i e i o S by e o el
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Printing Slides

Note Page Outline View

+[E3] TITLE SLIDE Outline View of slides
Printing in Notes Pages Printed in Color —_—
(3| Printing Whole Shides
D Office Button > Print
Slides printed in Noles Pages will display the OMake surs that Slides = salacted ?tm! Print wihat: boy
e i Oltis a good kdea to Scale shde to fit paper
speaker’s notes for making the presentation, Nkt U i i oo -Grinacslé b pare: Bl Sidwiis
These notes do not show on the screen during the :[E3] Printing Handouts
presentation O0ffice Button > Print
Oselect Handouts from the Sunt what: section
OSelect number of shides to print
OSelect Scale to fit paper
OSelect Frame slides
4[CJ] Printing Handouts for Notes
OOffice Button > Print
OSelect Handouts
OSelect 3 shdes per page
OSelect Scale to fit paper
OSelect Frame shides
5[] Printing in Notes Pages
These are my notes for this slide. OsSlides printed in Notes Pages will display the speaker’s notes for making the
presentation.

Printing inthis wview is 2 wayfor the spezskerto write his own jot notes sbout histalk OThese notes do not show on the screen during the presentation

while this slide is on the screen. 4[] Printing in Outline View
OCutline View shows the text only on the slides

The notes will printout whan the slide is printed in Motes Pages. These notes do not OQutline View printouts are often used to summarize the presentation
show on the screen during the presentation. OOutline View printouts can be given out as handouts
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Steps to Create a Presentation

1. Plan your content

O Ask yourself:
* What is the purpose of your presentation?

* What message do you want to deliver?

% Write up the outline with all the necessary topics
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Steps to Create a Presentation

2. Add details to all topics
o Add important details to all topics.
. Remove any unnecessary details
B Too much graphic/details can be distracting

O One idea per slide.
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Steps to Create a Presentation

3. Support the headline with graphic evidence
- support your points with graphic evidence.

B This can include photos, images, charts and

diagrams.
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Steps to Create a Presentation

4. Fine Tuning
- Fonts
9 Transition
% Animation

% Too much can be distracting
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Steps to Create a Presentation

5. Put details in the handouts

The handouts should have the necessary details

not included in the slides

PowerPoint supports printing in different formats

e.g. note pages, handouts
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Making Presentation

®Topic: Facts about Cat

®Length: 1 page
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Facts about Cats

® Scientific Name: felis catus
® Cats are carnivorous
®Young cats are called kitten

® Rub cat’s belly at your own risk!
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Scientific Name:. felis ¢

- Cats are carnivc 4\1.}
;:&3

-

_,Young cats are calle
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